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Mac environment. It supports simple but important practices for keeping 
your head clear, staying focused, and managing your commitments.” 

– David Allen

“OmniFocus is a stellar tool for keeping track of outcomes and actions in the
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GTD Workflow Diagram — Processing with OmniFocus
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The Basics of GTD in OmniFocus

Getting Things Done, or GTD, is a popular productivity methodology imagined 
and realized by David Allen. 

GTD is a way to manage everything from your day to day stuff to those dreams 
you don’t yet know how to accomplish. This manual intends to explore the im-
plementation of this system in OmniFocus, assuming no previous knowledge of 
the methodology on your part. At its simplest, GTD in OmniFocus can be sum-
marized with the following concepts:

Capture: Capture every little thought, to-do, or idea. When an idea is safely 
captured and off your mind, not only are you no longer burdened by it, but 
you’ve taken the first step towards making that idea come to fruition.

Organize: Organization is an ongoing process, but OmniFocus makes it 
easy. You can use OmniFocus to take your ideas and turn them into man-
ageable, bite-sized pieces. Instead of trying to tackle everything as it 
presents itself, you can make a game plan and take on your goals one step 
at a time. 

Do: With many systems, setting up the list is easy; it’s the doing that’s 
tough. But with GTD and OmniFocus, there’s nothing to it! OmniFocus 
makes use of GTD’s logical system to help you be the multi-tasking dy-
namo you know you are.

OmniFocus, while flexible enough for nearly any methodology, is a direct imple-
mentation of these principles. Unlike most other applications, it was created 
with GTD in mind. With OmniFocus, you can use the system comfortably, with-
out trying to fit a square peg into a round hole. 

Review: Keep in touch with your projects and actions to make sure they 
represent your ever-changing goals.

Process: Take a look at all your captured ideas one at a time and decide 
what it is and when you’ll accomplish it. That is, of course, if you are able 
and need to accomplish it. 

5



The OmniFocus interface is laid out to be as GTD-friendly as possible. However, 
that doesn’t mean much until we know what we’re looking for. This section will 
elaborate on the basics of GTD in OmniFocus.

OmniFocus Through the Eyes of a GTD Practitioner

1

2

Inbox: This is a place to capture your stuff. Stuff is anything that has your 
attention, be it general home upkeep, car repairs, or even screenplay ideas 
— enter it all in the Inbox. It doesn’t need to be fully worked out; it just 
needs to make enough sense that when you return to the Inbox, you can 
recall your intention for the entry.

1

2 Actions: For something to become an action, you must first 
Process your Inbox. This means going through your Inbox, line by line, 
and deciding what each item really is. Is it actionable? If so, what’s the 
next action? Most of your items will become projects or actions. In GTD, a 
project is defined as “any desired result that requires more than one ac-
tion step.”
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3

3 Contexts: A context is the tool, resource, or location required to complete 
an action. In OmniFocus, Context mode groups actions by their required 
context. This way, instead of working through a project action by action — 
which could take you to many different places or require different tools — 
you can consider what’s available to you now and go from there.

For example, let’s say you find yourself with a spare moment and decide 
to make some calls. You know you need to call your co-worker about that 
really important assignment, and your phone context shows that you need 
to return a call to your friend. Even though they’re from different projects, 
they can be accomplished with the same tool. (For more on Contexts, see 
page 14.)
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The Capture Process in OmniFocus

If you are distracted by what you are attempting to keep in your head, you will 
not be able to give your full attention to the task at hand. When everything is 
captured, your mind is a clear and can operate efficiently.

The Inbox is the central location to collect all of your important emails, your 
phone calls, your hastily written post-it notes, even your daydreams. Everything 
that requires eventual action on your part can start in the inbox. It doesn’t need 
to be fully developed; it just needs to get out of your mind. The first time you use 
OmniFocus, think of what’s on your mind and add it to the Inbox. This process 
is called a “mind sweep”. 

In general, once your know your next action, it is useful to add an action verb: 
“check tire pressure”, “clean up the attic”, “search for tickets to Madagascar”. 
This makes things clearer when it’s time to go to action.

Adding items directly to the Inbox
The easiest way to focus yourself on the Inbox is to press the Inbox button on 
the OmniFocus toolbar. Then, press the Add Action toolbar button or simply 
press Return.

Adding items to the Inbox with Quick Entry
You’re not always going to be working in OmniFocus when an idea strikes. 
Quick Entry is a window that can be called upon at any time OmniFocus is open, 
even if it isn’t the active application. To open Quick Entry, press Control-Option-
Space. Then, enter your item just as you would in the Inbox. Press Return, and 
your item goes straight to the OmniFocus Inbox. Settings for Quick Entry, in-
cluding its keyboard shortcut, can be customized in OmniFocus Preferences.
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Adding items to the Inbox with Clippings

Often, in order to complete your work, you need to refer to something on your 
computer, like an email or a web page. Clippings are bits of information that you 
put in your Inbox for later reference.

To get started, first open the Clippings pane of OmniFocus Preferences. In the 
Clippings Shortcut field, enter a shortcut. (It is best to choose an uncommon 
one that won’t conflict with other applications’ commands, such as Command–
F6.) Then, quit and reopen any applications where you’d like to use the shortcut.

Now, in a different application (your web browser, for example), select some 
text. Press your newly created shortcut, and Quick Entry appears. Enter a new ti-
tle for the item if you like, then press Return to save the item to the Inbox.

Adding to the Inbox with Apple Mail
You won’t always be in front of your computer when you need to enter some-
thing into OmniFocus. If you’re able to send email (for example, with your cell 
phone or a friend’s computer), you can send an email to yourself and have Om-
niFocus process it. To learn about processing actions from Mail, see page 32 of 
the OmniFocus manual, or the “Processing Mail messages into actions” section 
of OmniFocus Help. 

OmniFocus for iPhone has similar capture functionality to 
OmniFocus for Mac. Tap the New Inbox Item button on any screen 
to quickly add an inbox item from anywhere. Or, tap the Plus button 
to add an item to the screen you’re currently looking at.
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Processing and Organizing in OmniFocus

When working with Getting Things Done®, how you process and organize your 
work is key. Luckily, GTD organization is logical and OmniFocus makes it a snap. 
Organization is important because it will determine how your raw ideas become 
refined into lists you can take action on; those lists are pivotal to a successful 
workflow. Just like real life, these lists are dynamic. You will look over them regu-
larly and it’s easy to change them.

Processing the Inbox
Set aside time to process your inbox on a daily basis or select a time to process 
that regularly works for you. When you look at your Inbox, especially after your 
mind sweep, you’ll probably see a lot of different kinds of items. For now, all you 
need to decide is what the item is and if it is actionable — whether you intend to 
do something about it any time soon.

If an item is not actionable, you have three options:

Trash: If you’re not going to do it and you’re not going to have someone 
else do it, press Delete and stop worrying about it. Everyone thinks of 
more things to do than they have time for. When you decide what you’re 
not going to do, you’re deciding what’s really important to you. Deleting 
gives you more time to accomplish the important stuff.

Someday/Maybe: If you don’t want to lose it forever, because you might 
do something about it someday, at it to an On Hold single action list.

Reference: If you clipped something that you want to remember, but isn’t 
necessarily actionable, you can store it for reference. Different people have 
different methods for storing their reference materials, including fine ap-
plications such as OmniOutliner, VoodooPad, Evernote, Yojimbo, or even 
text files in Finder.
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If an item is actionable, you have another three options:

Do It: If it will take less than two minutes to do the action just go ahead 
and do it right now. (Go ahead, we’ll wait.)

Defer It: If you can’t do it right this minute, your remaining option is to 
defer it. (Most of your Inbox items are probably like this.) It’s time to de-
cide: Is it a project or is it a step to accomplish a project?

If it involves multiple steps rather than a single action turn it into a 
project and add at least one physical visible action that moves you to-
wards your successful outcome. 

If it is an action working toward an existing project, add it to that project 
via the item’s Project cell or by dragging it to the project in the sidebar.

If it is an action working toward a project that you haven’t created yet, 
create that project, and add the item to it. (A quick way to do this is to 
type the new project name into the item’s Project cell and then press 
Command-Return.)

Delegate It: If the action would be more efficiently completed by some-
one else, find the appropriate person and let them know what you expect 
of them. Keep track of the action in OmniFocus by assigning it to an On 
Hold context, thus marking the action unavailable for you to work on. By 
default, OmniFocus has a Context called Waiting, but you can also create 
one specific to the person who will be completing the action.

This way, if the action belongs in a project, but is not actionable by you, 
you will still see that the action needs to be completed instead of handing 
it off and watching it float into the ether. Once the other person gets back 
to you that they are finished with it, you can mark it complete and carry 
on with your part of the project.

You may find it helpful to create an action to follow up with them, adding 
a start and due date to remind you.
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Projects
A project is any desired result that requires more than one action to achieve. 
Making a decision about the order of your actions is very important. A project 
where the actions need to be performed in sequence is called a sequential 
project. A project where the actions can be performed in any order is called a 
parallel project. The project type can be specified either in the outline or the Pro-
ject Inspector. Often, they can only be performed in one order. 

No matter what the project type, considering a project’s next action will make 
accomplishing the project easier. The next action is the first action you need to 
take to move a project forward; it appears in purple text. You can set the next ac-
tion by dragging it above the others in the project.

Someday/Maybe Idea
Someday/Maybe ideas are those that aren’t really on your short-term agenda — 
like writing your autobiography or your opus (or just cleaning out the 
crawlspace). You’d like to do it someday, but you’re not ready to tackle it now.

You can specify an item as Someday/Maybe by placing it in a Single Action List. 
To do so, create a project, open the Inspector, and use the Type control. Use the 
Status control to specify the list as On Hold to hide it from the ordinary 
OmniFocus views. You can see your On Hold projects by choosing On Hold 
from the project filter menu at the far left of the View Bar or from the Sidebar Fil-
ter in the View menu.

Ticklers
If you can’t get to work on something right now, but it’s not too far off in the dis-
tance, you probably have a Tickler item on your hands. A tickler item, in Omni-
Focus, is an item with a start date in the future. This might be a marathon you 
might participate in or a concert you might like to see. With a start date in the 
future, it disappears for the time being, but is not lost forever. You can add a 
start date to the project or action via the inspector or the Start column in the 
outline.

An item with a start date in the future doesn’t appear in ordinary OmniFocus 
views. But when the start date comes around, the project or action appears 
again, ready for you to decide what to do with it.
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Folders
Folders are a way to organize projects. Many people use folders to represent life 
roles or areas of focus. For example, one might have folders named Work, 
Home, and so on. With such a system, when you are at work, you could use the 
Focus command on your Work folder to temporarily hide your Home folder and 
avoid being bothered by the fact that you need to call your landlord while you’re 
trying to focus on work.

Reviewing
Regular review of your actions and projects is central to making sure the GTD 

methodology works. OmniFocus has a built-in Review command that can be 
added to the toolbar or chosen from the Perspectives menu. Choose it to group 
your projects by the order in which they need review. This includes projects that 
have no actions known as Stalled projects. Give each project a once-over to 
make sure it still represents your goals, and adjust it if necessary. Then, select it 
and use the Mark Reviewed command (available as a toolbar button and as a 
command in the Edit menu). Like Inbox processing, it is good to establish a 
time to do this regularly without distraction. In this system, it is recommended 
to do this weekly. (See the weekly review chart for more on reviewing.)

Some people choose to use folders as a tool to implement the Horizons of 
Focus—Altitude Map Model. This model organizes your projects by your current 
actions, projects, areas of responsibility, one to two year goals, three to five year 
goals, and finally, general life goals. Everything from the phone call you need to 
make right now to how you ultimately envision for your life's purpose.

Review Templates
There may be other things you want to be reminded to check up on regularly, 
such as your physical inbox, your email accounts, and your mailbox at the office. 

To keep track of these day-to-day items, you can create a review template: 
Choose Add Single-Action List from the File menu, and add actions for the 
things you want to keep track of. Select each action and use the Inspector to give 
them a due date and a repeat interval (probably one day from completion date). 
Then, as long as you keep up with your due OmniFocus items, you can be sure 
that you’re on top of everything.
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Review Templates
There may be other things you want to be reminded to check up on regularly, 
such as your physical inbox, your email accounts, and your mailbox at the office. 

To keep track of these day-to-day items, you can create a review template: 
Choose Add Single-Action List from the File menu, and add actions for the 
things you want to keep track of. Select each action and use the Inspector to give 
them a due date and a repeat interval (probably one day from completion date). 
Then, as long as you keep up with your due OmniFocus items, you can be sure 
that you’re on top of everything.

OmniFocus for iPad has a mode dedicated solely to review. You can view each 
project on an individual basis to view and make changes to ensure that you 
are still happy with the project's course and that nothing is lost or forgotten.
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Completing Actions in OmniFocus

No matter which system you implement, if you can’t complete your actions, it’s 
all for naught. Thankfully, it’s easy and logical with GTD and OmniFocus; You 
can consider what tools and time are available to you to decide what to do next. 

Contexts

Contexts are a way to categorize actions by the tool, person, or place necessary 
to carry out the action. When you add actions, be sure to assign a context to 
them via the Context cell, or review the No Context list in Context Mode to add 
one later.

For example, let’s say you’re at the airport and you decide to make some phone 
calls. You have about 20 minutes, and your first call ends with time to spare. You 
can look at your Phone context and see several other calls that you need to 
make.

The phone call actions are from different projects, but the necessary tool is the 
same. So you quickly spot another short call you can make, from an unrelated 
project, and thus are able to move that project forward too. Without the context 
list, you might not have known that there was another phone call available.
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Time Estimates
There may be moments where you have a bit of spare time and you’d like to 
make use of it. While not central, you might find time estimates useful to narrow 
down what’s available to you. This is especially great for actions that take an 
hour or less because you can say, “Okay, I have 30 minutes” and see all the ac-
tions that can be accomplished in 30 minutes or less.

To add an estimate, use the Inspector or the Estimate column in the action out-
line. Then to see actions that fit into the time available to you, use the Estimate 
filter in the View Bar. 

Flagging
When you’re ready to get to work, you’ll likely find yourself with quite a few 
things you could work on. If it’s too much to concentrate on at once, you can 
flag certain items as being especially important to you right now.

Flagging doesn’t have any inherent meaning in OmniFocus, but you can use it, 
for instance, to mark the actions you intend to finish before lunch, some time 
today, or just sooner rather than later. Some people use flags to keep an eye on 
items that don’t have a hard due date, but which are particularly important. If 
you don’t get to them, simply unflag them.

This is equivalent to the GTD practice of writing down a special, selected list of 
actions to get done as soon as possible.

Perspectives
So, you’ve Focused on your folders, you’ve whittled down your Contexts, you’ve 
set your Flagged filter, and you’ve set your Estimate filter. That’s a lot to do to 
just try and get some work done. It would be nice if you didn’t have to set all that 
up every time you use OmniFocus.

Well, good news! You can create a Perspective. A Perspective saves a window’s 
view settings for recall later. You can create a Perspective for any window state. 
Just like to view your Stalled projects? No problem. Just arrange the window the 
way you’d like and save it as a new Perspective and add it to the toolbar with an 
icon of your choice, if you’d like. You can create and manage your Perspectives 
in the Perspectives window, available (appropriately enough) from the 
Perspectives menu. To learn more about Perspectives, check OmniFocus Help.
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Working With A Calendar
Calendars have been around for thousands of years and it’s because they’re a 
great tool for what they intend to accomplish: keeping track of and managing 
specific allotments of time, or “hard landscape” items. For a GTD practitioner 
this would include capturing your fixed appointments (like meetings and trips to 
the dentist) as well as capturing future options or reminders that need to occur 
on a specific date. 

OmniFocus doesn’t mean to replace the calendar, but rather work alongside it. 
When deferring actions, we can either create a next action in OmniFocus (to do 
as soon as possible) or we can add it to the calendar (to do at a specific time).

Working With Reference Material
Not everything that finds its way to your inbox requires action, but that doesn’t 
make it unimportant! Having a system to manage information you can use later 
is crucial. Phone numbers, addresses, coupons, take-out menus, lyrics scribbled 
on a napkin, and foreign currencies are all examples of something you want to 
keep and retrieve easily as needed. 

There are essentially two kinds of reference systems: one for information that’s 
specific to a topic or area (like with a phone number) and one for general refer-
ence (like employee files or currencies for later travel).

While much of this can be stored electronically with applications like 
OmniOutliner or Yojimbo, it’s good to have a physical file that is kept tidy and 
well-labeled.

Beyond OmniFocus17



Additional Help

The GTD methodology can greatly improve your productivity while reducing 
your stress, but it takes time to learn its best practices. Fortunately, you’re not 
alone!

A good place to start is David Allen’s book, Getting Things Done. You can pur-
chase it from his website:

http://www.davidco.com/

You can also talk with other OmniFocus users on the Omni Group forums: 
       http://forums.omnigroup.com/

Or, get in touch with our Support Ninjas via email: 
       omnifocus@omnigroup.com
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Map of GTD &  OmniFocus Concepts

Action

Area of Focus 

Context

Defer

Delegate

Hard Landscape

Inbox

Next Action

Project

Review

Someday/Maybe

Stuff

Tickler

Individual action items in a project.

These areas of responsibility can be represented as fold-
ers, on which you can use the Focus command.

To see your actions grouped by context, click the Contexts 
toolbar button.

Make an on-hold project or use a future start date to get 
tasks off your plate for the time being.

Assign actions to an on-hold context until you hear back 
from the person you have delegated them to.

OmniFocus doesn’t replace your calendar; use iCal, 
Google Calendar, or any application you like.

Click the Inbox toolbar button, summon the Quick Entry 
window, or use the Clippings shortcut.

Each project’s next action is purple. You can use the next 
action filter on the View Bar to see only next
actions.

Use the Projects toolbar button to see your projects.

Use the Review command and repeating actions to make 
sure you’re on top of everything.

Set a project’s status to on hold if you don’t intend to do 
it any time soon; review these projects as needed.

Everything you put in the Inbox to become actions, 
projects, calendar items, or reference materials.

Give an item a future start date to file it for later.
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The Weekly Review

Get Clear
Collect Loose Papers and Materials: Gather all accumulated business cards, 
receipts,and miscellaneous paper-based materials into your inbox.

Get “IN” to Zero: Process completely all outstanding paper materials, journal 
and meeting notes, voicemails, dictation, and email.

Empty Your Head: Put in writing and process any uncaptured new projects, 
action items, waiting-for's, someday/maybe's, etc.

Get Current
Review Action Lists: Review for reminders of further action steps to record.

Review Previous Calendar Data: Review past calendar in detail for remaining 
action items, reference data, etc. and transfer into the active system. 

Review Upcoming Calendar: Review upcoming calendar events — long and 
short term. Capture actions triggered.

Review Waiting-For List: Record appropriate actions for any needed follow-up. 
Check off received ones.

Review Project (and Larger Outcome) Lists: Evaluate status of projects, goals 
and outcomes, one by one, ensuring at least one current action item on each. 
Browse through project plans, support material, and any other work-in-progress 
material to trigger new actions, completions, waiting-for's, etc.

Review Any Relevant Checklists: Use as a trigger for new actions.

Get Creative
Review Someday/Maybe List: Review for any projects which may now have 
become active, and transfer to "Projects".

Be Creative and Courageous: Any new, wonderful, hare-brained, creative, 
thought-provoking, risk-taking ideas to add into your system?
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© 2009 The Omni Group
OmniFocus is a trademark of the Omni Group
GTD and Getting Things Done are registered trademarks of David Allen & Co.

To learn more about GTD and David Allen, visit his website at 
http://www.davidco.com/. There you can buy the GTD book and 
learn about the system outside the context of OmniFocus. You can 
also find links to articles, forums, videos, and blogs, and connect 
with other folks who are discovering GTD.
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